
REFERENCE 
 
This section of the help system is the Reference, and allows the user to find information 
about specific windows within GCA. This section does not cover how to do particular 
tasks, it only offers information about what the windows, and various parts of those 
windows, will do. 



Main GCA Window 
 
The main GCA window is shown here, with the major sections of the window highlighted 
in different colors to help differentiate them. 
 

 
 
The standard Windows title bar is at the top of the screen. Below that are the menu bar 
and the toolbars. 
 
At the bottom of the screen is a status bar with point values. Above that are character tabs 
and trait tabs. 
 
The middle area is where you find the content of the various trait pages, where you can 
work with character data based on the current trait tab. What exactly you’ll see here 
depends on which trait tab you have active. In the example window above, the Quick 
View tab is being displayed. 
 
You can find more information about the various parts of the main GCA window by 
reading the following topics: 
 
Menu Bar 
Toolbars 
Trait Pages 
Trait Tabs 
Character Tabs 



Toolbars 
 
The toolbars allow you to quickly access GCA’s standard file functions, such as loading 
and saving characters, as well as the major dialogs that help you work on different 
aspects of your character, such as the protection and portrait windows. The toolbars are 
shown below. 
 

 
 
The toolbar buttons shown on the first toolbar are fairly standard ones. In order, from left 
to right, they are: 
 

 New: Creates a new character for you to work on. 
 

 Open: Calls up the dialog that will let you load a previously saved character into 
GCA. 

 

 Save: Saves the character currently being worked on. 
 

 Close: Closes the character currently being worked on, without closing GCA. 
 

 Print: Prints the current character to your printer. 
 

 Preview: Displays a preview of what the current character will look like when 
printed to your printer. 

 

 Options: Opens the Options window, which will allow you to set a variety of 
options and preferences within GCA. 

 

 Character Sheet Options: Opens the Character Sheet Options window, which 
will allow you to set a variety of options and preferences for various character 
sheets you can use to print, preview, or export from within GCA. 

 
The toolbar buttons shown on the second toolbar are specific to GCA, but call up various 
useful dialogs. In order, they are:  
 

 Campaign Log: Opens the Campaign Log window, allowing you to make log 
entries and input earned character points. 

 



 Campaign Settings: Opens the Campaign Settings window, allowing you to set 
campaign values for character points and tech level. 

 

 Load-Out Manager: Opens the Load-Out Manager window, which allows you to 
create load-outs and set various loads for your character, including the load-out 
used to determine encumbrance. (Note that this option is only available if you 
have already added some equipment to your character.) 

 

 Protection: Opens the Protection window, which allows you to enter values for 
DR for various areas, as well as select the Parry and Block skills to use on the 
character sheet. 

 

 Appearance: Opens the Appearance window, allowing you to set the race, 
height, weight, and age for your character. You can also use it to enter a simple 
description of your character’s appearance. 

 

 Portrait: Opens the Portrait window, which allows you to load and view graphics 
files, selecting one to use as a character portrait. 

 

 Notes: Opens the Description/Notes window, which allows you to enter text notes 
for your character. 

 

 Find Traits: Opens the Find Traits dialog, where you can search for traits. 
 
On the left side of each toolbar is a toolbar handle, as indicated here: 
 

 
 
You can grab the handle on the second toolbar to pull it up next to the first toolbar, and 
therefore use up less space in the window for the two toolbars. If you do that, the toolbars 
might look like this: 
 

 
 
Be aware that you can cover the first toolbar with the second toolbar. You can click on 
the toolbar handle to expand or collapse the toolbars that you’re viewing, so you can 
always get back a hidden toolbar. 



Trait Tabs 
 
The trait tabs allow you to switch easily between the different trait pages for the 
character. The current trait tab is shown in bold. You can change to a different trait by 
clicking the tab for that trait. GCA currently has tabs for each of the major trait types you 
work with in GURPS (including attributes, advantages, skills, etc.), as well as equipment, 
and a Quick View (which is like a print preview with edit fields). 
 
Shown below is an example of the trait tabs. The user is currently working on the Quick 
View page, so it is shown in bold. 
 

 
 
If you look to the far left side of the example, you can see the scroll button for the tabs. 
It’s indicated here, along with similar buttons on the character tabs and status bar: 
 

 
 
This button will let you horizontally scroll through the tabs that are not visible within the 
window. This will happen if your window is not wide enough to show all the available 
trait tabs. In this case, the Attributes tab is currently off the screen to the left. 
 
A similar button will appear on the right side of the tab strip, if you have scrolled to the 
left. 
 
You can close the currently active tab by right-clicking anywhere on the trait tabs strip, 
and selecting Close Active Tab from the pop-up menu that appears. 
 
If you close any trait tabs, they will not appear among the trait tabs again until you reload 
that tab using the Recall sub-menu under the Tabs menu. 
 
Alternatives 
 
You can also move between trait tab pages by using CTRL+TAB, much the same way as 
you can move between applications in Windows by using ALT+TAB. 
 



Character Tabs 
 
If you have more than one character loaded into GCA at one time, you will see the name 
of each of those characters appear as a tab along this strip of the window. The character 
you are currently working on is shown in bold. You can change to a new character by 
clicking that character’s tab. 
 
Here is an example of character tabs with multiple characters loaded. 
 

 
 
The current character is Dai Blackthorn. 
 
If you look to the far right side of the example, you can see the scroll button for the tabs. 
It’s indicated here, along with similar buttons for the trait tabs and the status bar. 
 

 
 
This button will let you horizontally scroll through the tabs that are not visible within the 
window. This will happen if you load a lot of characters, or give them long names. 
 
A similar button will appear on the left side of the tab strip, if you have scrolled to the 
right. 
 
You can close the currently active character by right-clicking anywhere on the character 
tabs strip, and selecting Close Active Tab from the pop-up menu that appears. 
 
Alternatives 
 
You can also switch between characters by pressing CTRL+1 for the first character, 
CTRL+2 for the second, etc, up to CTRL+9 for the ninth character, and CTRL+0 for the 
tenth character. These shortcut keys will only work for the first 10 characters, in the order 
displayed in the character tabs. 
 
If you want to switch to a character not currently loaded, you must first load that 
character into GCA. 



Menu Bar 
 
The menu bar allows you access to the various menus within GCA. The menu bar is 
shown below. 
 

 
 
The various menus are: 
 
File: Access to the various filing functions of GCA, such as opening and saving 
characters, printing, etc. 
 
Edit: Currently disabled, since very little of what you do in GCA makes use of standard 
editing conventions. 
 
View: Allows you to toggle view options for certain window features, such as the 
toolbar, and the character and window tabs. It also allows you to load a variety of other 
windows that let you work on certain aspects of the character that aren’t handled by any 
of the various trait windows, such as campaign settings, notes, or loading a character 
portrait. 
 
Needs: This special menu allows you to quickly run a prerequisite check against various 
types of traits on the character. While GCA is pretty good at checking for satisfied 
prerequisites as you work, there are a variety of cases where that’s not possible, so a 
handy way to verify that some items might still have unsatisfied needs is important. 
 
Tools: Access to certain specialized tools within GCA, such as re-synchronizing a 
character with loaded data files, or validating the compliance of a character’s traits 
against the official data. 
 
Party: Access to a couple custom tools for working with a character party: saving the 
party to a file, and updating all the currently loaded character’s logs at once. 
 
Tabs: Access to the various trait tab pages (just like clicking on the trait tabs), as well as 
offering ways to recall closed tabs. 
  
Help: The help system, and various links to Internet resources. 
 
At the far end of the menu bar is the Close Character button. You can click on this button 
to close the character you’re currently working on. 



File Menu 
 
 

 
 
The various File menu options are: 
 
New: Creates a new character for you to work on in GCA. You can use the CTRL+N 
shortcut key to quickly launch this menu option without opening the File menu. 
 
Open…: Opens a standard Windows File Open dialog, allowing you to find an existing 
character that you’d like to load into GCA. You can use the CTRL+O shortcut key to 
quickly launch this menu option without opening the File menu. 
 
Close: Closes the current character in GCA, without closing GCA itself. 
 
Close All: Closes all the currently loaded characters, without closing GCA itself. 
 
Save: Saves the current character to disk. If you have not saved the character before, it 
will ask you for a file name for the character, as if you had chosen Save As… instead. 
You can use the CTRL+S shortcut key to quickly launch this menu option without 
opening the File menu. 
 
Save As…: Opens a standard Windows File Save dialog, allowing you to specify a file 
name for the current character, which will then be saved to disk. 



 
Save All: Saves all the currently loaded characters to disk. If any of the characters have 
not been saved before, it will ask for file names for those characters, as if you had chosen 
Save As… for each one. 
 
Print: Prints your character to the currently selected printer, using the character sheet 
specified for the character in Options. You can use the CTRL+P shortcut key to quickly 
launch this menu option without opening the File menu. 
 
Print Preview: Prints your character to the screen, in the Print Preview window, which 
will allow you to see what your character’s printed character sheet will look like. 
 
Print Setup…: Opens a Print Setup dialog and allow you to specify which printer you’d 
like to use when printing your character from GCA. From the Print Setup dialog, you can 
also set properties for your selected printer. 
 
Print Using…: Allows you to print your character to your printer, but allows you to first 
specify the character sheet you’d like to use when doing so. This allows you to print 
using a custom character sheet without having to change the character sheet specified for 
the character in Options. 
 
Print Preview Using…: As with Print Using, this allows you to preview in the Print 
Preview window what your character would look like when printed with a character sheet 
specified after selecting this option. 
 
Export…: Allows you to set what export filter to use, and to export your character to one 
of several different formats. 
 
1 through 4: Up to four Most Recently Used character files, or character party files, are 
listed here, which allows you to quickly open a recent character or group of characters. 
 
Exit: Exits from GCA. 
 



View Menu 
 
 

 
 
The various View menu options are: 
 
Toolbar: Shows, or hides, the main window toolbars. This option is checked if the 
toolbars are currently shown. 
 
Character Tabs: Shows, or hides, the character tab strip. This option is checked if the 
character tabs are currently shown. (You can change the position of the tabs, to the top or 
bottom of the window, in Options.) 
 
Trait Tabs: Shows, or hides, the trait tabs strip. This option is checked if the trait tabs 
are currently shown. (You can change the position of the tabs, to the top or bottom of the 
window, in Options.) 
 
Logging Window: Allows you to show the Logging Window, if it’s currently closed. 
The Logging window is loaded by default. 
 
View Info Window: Allows you to show the View Info window, if it’s currently closed. 
The View Info window is closed by default. If you load the View Info window, you can 
use it to see a variety of data about items you click on in the Available traits lists of the 
various trait tabs. 
 
Appearance: Opens the Appearance window, allowing you to set the race, height, 
weight, and age for your character. You can also use it to enter a simple description of 
your character’s appearance. 



 
Campaign Log: Opens the Campaign Log window, allowing you to make log entries and 
input earned character points. 
 
Campaign Settings: Opens the Campaign Settings window, allowing you to set 
campaign values for character points and tech level. 
 
Description: Opens the Description/Notes window, allowing you to enter a description 
for your character, his property, etc. 
 
Load-Out Manager: Opens the Load-Out Manager window, which allows you to create 
load-outs and set various loads for your character, including the load-out used to 
determine encumbrance. (Note that this option is only available if you have already added 
some equipment to your character.) 
 
Notes: Opens the Description/Notes window, which allows you to enter text notes for 
your character. 
 
Portrait: Opens the Portrait window, which allows you to load and view graphics files, 
selecting one to use as a character portrait. 
 
Protection: Opens the Protection window, which allows you to enter values for DR for 
various areas, as well as select the Parry and Block skills to use on the character sheet. 



Needs Menu 
 
 

 
 
The various Needs menu options are: 
 
Check All: Tests all the needs (prerequisites) for all of the traits on the character. It will 
display a window if any are not satisfied, listing how they failed. 
 
Advantages, Disadvantages, Skills, Spells, Templates: These options are all basically 
identical; they check the specific type of traits mentioned for needs. In each case, as 
shown below, you can select either Check All or Check Marked. 
 

 
 
If Check All is selected, then all traits of that type will be checked for missing 
prerequisites. If Check Marked is selected, then only traits that are currently selected on 
the Character list in the appropriate workspace will be checked for missing prerequisites. 
 
As with Check All, a window will be shown with the reason for any unsatisfied needs. 



Tools Menu 
 
 

 
 
The various Tools menu options are: 
 
Recalculate Everything: Forces GCA to recalculate all the traits on the character. You 
can use the F5 shortcut key to quickly launch this menu option without opening the Tools 
menu. 
 
Resynchronize…: Opens the Resynchronize window. 
 
This tool is essential for updating all of a character’s traits at one time, rather than having 
to remove and re-add various traits in order to update them with newer information 
available in an updated data file. 
 
(GCA stores all the needed information for a trait with the character, so that the character 
can be viewed and edited correctly even if the data files used to create that character are 
not available. This means, however, that updated data in a data file will not automatically 
be applied to the character the next time you load it up. The only way to get the updated 
data into the character is to resynchronize.) 
 
Validate Fourth Edition Compliance: Loads a valid set of approved GURPS Fourth 
Edition data files, and then runs a check against the character to make sure that all the 
traits found on the character match traits found in the Fourth Edition data files. 
 
Validate Against Current Files: Checks the character to make sure that all the traits 
found on the character match traits found in the currently loaded data files. This is handy 
for GMs to check characters against their custom campaign data files. 
 
Find Trait...: Opens the Find Traits dialog, where you can search for traits. 
 
Character Sheet Options…: Opens the Character Sheet Options window. 
 
Options…: Opens the Options window. 



Party Menu 
 
 

 
 
The various Party menu options are: 
 
Save Party List…: Allows you to save a party list file based on all the currently loaded 
characters. A party list file is a kind of “play list” for characters, and will allow you to 
open all of the characters specified in that list, at one time. When selected, this option 
opens a standard Save As dialog, which will allow you to name the party file. The next 
time you run GCA, you can then open the party list file as if you were loading any single 
character. 
 
Note: GCA does not save the characters into the party list file, only references to their file 
names. GCA also does not save the characters themselves when it saves the party list file; 
you’ll still need to do that for each individual character to save their changes. You do not 
need to save the party list file again, unless the characters belonging to that party change 
or you have renamed or moved one or more of the character files. 
 
Party Log Entry: Opens the Add Party Log Entry window. 



Tabs Menu 
 
 

 
 
 
The various Tabs menu options are: 
 
Recall: Opens a sub-menu, which lists all the currently closed tabs. You may click on 
any listed tab in order to open it again. Note that GCA will sometimes have closed tabs 
for you, because there were no available traits to list in them. 
 
Recall All: Opens all of the currently closed tabs. 
 
At the bottom of the Tabs menu is a listing of the currently open tabs. You can switch to 
any listed tab by selecting it here, much as you can by clicking the name on the trait tabs 
strip. The currently active tab will have a check mark next to it. 



Help Menu 
 
 

 
 
The various Help menu options are: 
 
Reference…: Calls up the GCA Reference, which you are reading right now. 
 
Tutorial…: Calls up the GCA Tutorial, which is a guide through the basic features of 
GCA. 
 
About GCA…: Calls up the GCA splash screen, which includes basic information about 
GCA, such as the copyright notice and version. 
 
Credits…: Calls up the GCA credits screen, which includes credits for authors, testers, 
artists, etc. for GCA. 
 
At the bottom of the help menu is a section of links to various web sites related to GCA. 
These links may vary, but most of the time will include the general GCA web site, the 
GCA support site and forum, the GURPS game web site, and general Steve Jackson 
Games pages. 



Right-Click Menu 
 
Right-clicking with your mouse inside a character’s trait listing will reveal a menu of 
additional options (not available on the Quick View page):  
 

 
 
Show: This option opens a sub-menu: 
 

 
 
 

Show Hidden Items: This option will reveal hidden character traits. In the 
example below, the hidden advantages are in gray. (They are also highlighted in 
yellow, because they are components of the Dwarf template.) 
 

 
 
Show Components: This option will show you the component items that make up 
other, more complex items on the current trait list. Below is an example, showing 
the components (highlighted in yellow) of the Dwarf template, from the Character 



Templates list of the Templates window. (They are also shown in grey, because 
they are normally hidden.) 

 

 
 
Component: This option opens a sub-menu: 
 

 
 

Disable Component: This option allows you to specifically disable a component 
trait of a template. If you select this option when one or more component items 
are selected, they will be disabled, and any impact they have on the character will 
no longer apply. Below is an example of a disabled component, with Night Vision 
from the Dwarf template disabled. 

 

 
 

Note that disabling a component has no effect on the price of the template. Also 
notice that disabling a component generates a new trait, which has the opposite 



point value of the disabled one. The new trait is considered a part of the template, 
but is not a component of it in the typical sense, so it is not hidden or highlighted 
yellow. 

 
Re-Enable Component: This option is the opposite of Disable Component. If 
you select a component that has been disabled, you can choose this option to re-
enable it as part of the template. 

 
Needs: This option opens a sub-menu: 
 

 
 

Needs Check All <traits>: This option allows you to quickly “needs check” all 
the current traits. If you right-clicked in the Advantages page, for example, you’d 
see Advantages instead of <traits>, as shown in the example above. This function 
is useful for checking for missing prerequisites after making substantial changes 
to a character. 

 
Needs Check Marked <traits>: This option allows you to quickly “needs check” 
the selected traits on the current page. As above, <traits> will be replaced with the 
type of trait that you’re currently working with. 

 
Duplicate Selected: This option allows you to easily duplicate the currently selected 
trait. The duplicate will be exactly the same as the original trait, including any applied 
enhancements or limitations. If the first item was a component part of a template, 
however, the duplicate won’t be. 
 
Create Optional Specialty…: This option allows you to quickly create an optional 
specialty of the selected skill. This option is disabled when you aren’t on the Skills page. 
 
Make Parent: This option allows you to mark the selected items as parent items. The 
only thing that makes parent items different from other items is that they will appear in 
the selection list when you choose Make Child of… for another item. Items that are not 
marked as parents will not appear in the list. 
 
Unmake Parent: This option allows you to remove the parent marker from an item. If 
the item has child items, they remain child items. Just because an item is not marked as a 
parent does not mean that it can not have child items, it just will not appear in the 
selection list when Make Child of… is selected for another item. 
 
Make Child of…: This option allows you to select a parent item which the currently 
selected items will be made children of. Child items contribute their costs to the parent 



item, and are organized below the parent items in the various trait lists in GCA. By 
default, child items are not displayed in GCA, so you will need to use the Show > Show 
Components option from the right-click menu to see components in the Character lists of 
the trait page you’re interested in. 
 
Unmake Child: This option allows you to make an item independent again, and no 
longer a child of another item. This has no effect if the selected item is not already a child 
item. 



Trait Pages 
 
The trait pages are where you’ll do most of your work in GCA, operating on various 
pages depending on which trait tab is currently active. Most of the pages you’ll use work 
in a similar fashion, except the Attributes and Quick View pages. 
 
The Attributes Page 
The Advantages Page 
The Perks Page 
The Disadvantages Page 
The Quirks Page 
The Skills Page  
The Spells Page 
The Equipment Page 
The Templates Page 
The Quick View Page 



Attributes Page 
 
 

 
 
This page allows you to access and modify the most common attributes you’ll work with 
on most characters. It also provides access to other useful information, such as the name 
of the character and encumbrance values. 
 
The attributes available are listed in the list box on the left side of the page. 
 
Notice the Edit button near the bottom of the page. If you need to change an attribute for 
some reason, you can select the attribute, then click this button to edit it. Very 
Important: You should not edit the names of attributes, as GCA requires attributes to 
have specific names in order to find them correctly.  
 
There are two smaller buttons next to the Edit button: an up and a down arrow. They 
allow you to change the values of selected traits. 
 
If you click on an attribute in the attribute list, you can use the up/down buttons to change 
its level. You’ll see the value in the Pts column change as the attribute changes. You may 
also notice some of the values in other parts of the window changing as you make 
changes to various attributes. Most changes will happen “live” as you edit traits in GCA. 
 
You may also change attribute scores on this page by typing them in directly. If you click 
on a score for an attribute, you can then type in a value. Press TAB or ENTER after you 
enter the value, and GCA will make the appropriate changes. 
 
Table View 
 



A different version of the Attributes page, Table View, is available by using the tabs at 
the bottom of the page. If you click the Table View tab, you’ll see the page shown below. 
 

 
 
This view shows all the various attributes for the character alphabetically, along with its 
abbreviation if any, the current score, and points spent. 
 
In this view, you can’t directly type in a score for an attribute, but you have the same Edit 
and up/down buttons at the bottom of the window, so you can still change the scores of 
many of these attributes. Note that some will be displayed, but will not actually be 
adjustable.  
 
There may also be some attributes that GCA hides from you, in order to reduce the clutter 
in the listings. Usually, hidden traits are not ones that you need to be concerned about. 
You can see hidden traits, if you wish to do so, by selecting Show Hidden Items on the 
right-click menu. 



Advantages Page 
 
 

 
 
This page allows you to manage advantages for your character. You can add new 
advantages by selecting them in the Available Advantages list on the left side, and then 
clicking the Add button in the middle of the page. You can also double-click on an 
available trait to add it immediately to the character. 
 
Some traits in the Available list have a wrench icon next to them. When you add this trait 
to a character, GCA will request additional information from you before the trait is added. 
Usually this is nothing more than a small window requesting you to specify a particular 
specialty or something similar. However, on occasion, GCA will display the Modifiers 
window for additional details. In either case, if you click Cancel, the requested trait will 
not be added. 
 
If you select a trait in the Character Advantages list on the right, you can remove it by 
clicking the Remove button in the middle of the page. 
 
Some traits in the Character list may appear in blue text. This means the trait is getting a 
bonus of some kind – to see exactly what, click on the Edit button. 
 
There are other icons you may find next to traits in the Character list, as follows: 
 

 The trait has multiple levels. 

 The trait has missing prerequisites. 

 The trait is taboo or has taboo qualities for this character. (You can see the details 
in the Edit window.) 

 



You may even see two or more icons displayed at the same time. If the taboo icon is 
shown at the same time as another icon, it will lose the circle, and simply have a yellow 
background with the exclamation point. 
 
Near the bottom of the page, on the right side, there is a small group of buttons: the Edit 
button, a small button with a hammer & chisel icon, and an up/down button. 
 
The Edit button will allow you to edit the currently selected item in the Character list. 
You can also call up the edit window by double-clicking an item in the Character list. 
 
The button with the hammer & chisel icon is the Modifiers button. It will call up the 
Modifiers window for the currently selected item.  
 
The up/down button allows you to adjust the level of the currently selected item.  
 
At the top of the page is a drop-down list. This allows you to change the category of traits 
viewed on the page. The default is always ”All Categories.” If you change it to a specific 
category, you’ll only see items belonging to that category in both columns. 
 
At the bottom of the page is a long, thin button with an up-caret icon. This will open and 
close the description area at the bottom of the page. If an item in the Available list has a 
description included, it will be displayed here when you click on it. 



Perks Page 
 

 
 
This page allows you to manage perks for your character. You can add new perks by 
selecting them in the Available Perks list on the left side, and then clicking the Add 
button in the middle of the page. You can also double-click on an available perk to add it 
immediately to the character. 
 
If you select a perk in the Character Perks list on the right, you can remove it by clicking 
the Remove button in the middle of the page. 
 
Near the bottom of the page, on the right side, there is a small group of buttons: the Edit 
button, a small button with a hammer & chisel, and an up/down button. 
 
The Edit button will allow you to edit the currently selected item in the Character list. 
You can also call up the edit window by double clicking an item in the Character list. 
 
The button with the hammer & chisel icon is the Modifiers button. It will call up the 
Modifiers window for the currently selected item.  (Generally, you won’t apply modifiers 
to a perk.) 
 
The up/down button allows you to adjust the level of the currently selected item. 
(Generally, you won’t be able to adjust levels for perks.) 
 
At the top of the page is a drop-down list. This allows you to change the category of traits 
viewed on the page. The default, is always “All Categories.” If you change it to a 
different category, you’ll only see items belonging to that category in both columns. 
 



At the bottom of the page is a long, thin button with an up-caret icon. This will open and 
close the description area at the bottom of the page. If an item in the Available list has a 
description included, it will be displayed here when you click on it. 
 



Disadvantages Page 
 
 

 
 
This page allows you to manage disadvantages for your character. You can add new 
disadvantages by selecting them in the Available Disadvantages list on the left side, and 
then clicking the Add button in the middle of the page. You can also double-click on an 
available trait to add it immediately to the character. 
 
Some traits in the Available list have a wrench icon next to them. When you add this trait 
to a character, GCA will request additional information from you before the trait is added. 
Usually this is nothing more than a small window requesting you specify a particular 
specialty or something similar. However, on occasion, GCA will display the Modifiers 
window for additional details. In either case, if you click Cancel, the requested trait will 
not be added. 
 
If you select a trait in the Character Disadvantages list on the right, you can remove it by 
clicking the Remove button in the middle of the page. 
 
Some traits in the Character list may appear in blue text. This means the trait is getting a 
bonus of some kind – to see exactly what, click on the Edit button. 
 
There are other icons you may find next to traits in the Character list, as follows: 
 

 The trait has multiple levels. 

 The trait has missing prerequisites. 

 The trait is taboo or has taboo qualities for this character. (You can see the details 
in the Edit window.) 

 



You may even see two or more icons displayed at the same time. If the taboo icon is 
shown at the same time as another icon, it will lose the circle, and simply have a yellow 
background with the exclamation point. 
 
Near the bottom of the page, on the right side, there is a small group of buttons: the Edit 
button, a small button with a hammer & chisel icon, and an up/down button. 
 
The Edit button will allow you to edit the currently selected item in the Character list. 
You can also call up the edit window by double clicking an item in the Character list. 
 
The button with the hammer & chisel icon is the Modifiers button. It will call up the 
Modifiers window for the currently selected item directly.  
 
The up/down button allows you to adjust the level of the currently selected item.  
 
At the top of the page is a drop-down list. This allows you to change the category of traits 
viewed on the page. The default is ”All Categories.” If you change it to a specific 
category, you’ll only see items belonging to that category in both columns. 
 
At the bottom of the page is a long, thin button with an up-caret icon. This will open and 
close the description area at the bottom of the page. If an item in the Available list has a 
description included, it will be displayed here when you click on it. 



Quirks Page 
 
 

 
 
This page allows you to manage quirks for your character. You can add new quirks by 
selecting them in the Available Quirks list on the left side, and then clicking the Add 
button in the middle of the page. You can also double-click on an available quirk to add it 
immediately to the character. 
 
If you select a quirk in the Character Quirks list on the right, you can remove it by 
clicking the Remove button in the middle of the page. 
 
Near the bottom of the page, on the right side, there is a small group of buttons: the Edit 
button, a small button with a hammer & chisel icon, and an up/down button. 
 
The Edit button will allow you to edit the currently selected item in the Character list. 
You can also call up the edit window by double clicking an item in the Character list. 
 
The button with the hammer & chisel icon is the Modifiers button. It will call up the 
Modifiers window for the currently selected item.  (Generally, you won’t apply modifiers 
to a quirk.) 
 
The up/down button allows you to adjust the level of the currently selected item. 
(Generally, you won’t be able to adjust levels for quirks.) 
 
At the top of the page is a drop-down list. This allows you to change the category of traits 
viewed on the page. The default is always ”All Categories.” If you change it to a different 
category, you’ll only see items belonging to that category in both columns. 
 



At the bottom of the page is a long, thin button with an up-caret icon. This will open and 
close the description area at the bottom of the page. If an item in the Available list has a 
description included, it will be displayed here when you click on it. 



Skills Page 
 
 

 
 
This page allows you to manage skills for your character. You can add new skills by 
selecting them in the Available Skills list on the left side, and then clicking the Add 
button in the middle of the page. You can also double-click on an available skill to add it 
immediately to the character. 
 
Some traits in the Available list have a wrench icon next to them. When you add this skill 
to the character, GCA will request additional information from you, before the skill is 
added. Usually, this is nothing more than a small window requesting a particular 
specialty, or something similar. If you click Cancel, the requested skill will not be added. 
 
If you select a skill in the Character Skills list on the right, you can remove it by clicking 
the Remove button in the middle of the page. 
 
Some skills in the Character list may appear in blue text. This means the skill is getting a 
bonus of some kind – to see exactly what, click on the Edit button. 
 
There are other icons you may find next to skills in the Character list, as follows: 
 

 The skill is defaulted from another skill, or an attribute. 

 The skill has missing prerequisites. 

 The skill is taboo or has taboo qualities for this character. (You can see the details 
in the Edit window.) 

 



You may even see two or more icons displayed at the same time. If the taboo icon is 
shown at the same time as another icon, it will lose the circle, and simply have a yellow 
background with the exclamation point. 
 
Near the bottom of the page, on the right side, there is a small group of buttons: the Edit 
button, a small button with a hammer & chisel icon, and an up/down button. 
 
The Edit button will allow you to edit the currently selected skill in the Character list. 
You can also call up the edit window by double clicking an skill in the Character list. 
 
The button with the hammer & chisel icon is the Modifiers button. It will call up the 
Modifiers window for the currently selected skill.  
 
The up/down button allows you to adjust the level of the currently selected skill.  
 
You may also change skill levels on this page by typing them in directly. If you click on 
the level for a skill, you can then type in a value. Press TAB or ENTER after you enter 
the value, and GCA will make the appropriate changes, and determine the points required 
to have that level of the skill. 
 
Likewise, you may enter the points spent on the skill by clicking on the point value, and 
then typing in a new value. Press TAB or ENTER after you enter the value, and GCA 
will make the appropriate changes, and determine the level based on the points entered. 
 
At the top of the page is a drop-down list. This allows you to change the category of 
skills viewed on the page. The default is ”All Categories.” If you change it to a specific 
category, you’ll only see skills belonging to that category in both columns. 
 
At the bottom of the page is a long, thin button with an up-caret icon. This will open and 
close the description area at the bottom of the page. If a skill in the Available list has a 
description included, it will be displayed here when you click on it. 



Spells Page 
 
 

 
 
This page allows you to manage spells for your character. You can add new spells by 
selecting them in the Available Spells list on the left side, and then clicking the Add 
button in the middle of the page. You can also double-click on an available spell to add it 
immediately to the character. 
 
If you select a spell in the Character Spells list on the right, you can remove it by clicking 
the Remove button in the middle of the page. 
 
Some spells in the Character Spells appear in blue text. This means the spell is getting a 
bonus of some kind – to see exactly what, click on the Edit button. 
 
There are other icons you may find next to spells in the Character Spells list, as follows: 
 

 The trait has missing prerequisites. 

 The trait is taboo or has taboo qualities for this character. (You can see the details 
in the Edit window.) 

 
You may even see two or more icons displayed at the same time. If the taboo icon is 
shown at the same time as another icon, it will lose the circle, and simply have a yellow 
background with the exclamation point. 
 
Near the bottom of the page, on the right side, there is a small group of buttons: the Edit 
button, a small button with a hammer & chisel icon, and an up/down button. 
 



The Edit button will allow you to edit the currently selected item in the Character list. 
You can also call up the edit window by double clicking an item in the Character list. 
 
The button with the hammer & chisel icon is the Modifiers button. It will call up the 
Modifiers window for the currently selected item.  
 
The up/down button allows you to adjust the level of the currently selected item.  
 
You may also change spell levels on this page by typing them in directly. If you click on 
the level for a spell, you can then type in a value. Press TAB or ENTER after you enter 
the value, and GCA will make the appropriate changes, and determine the points required 
to have that level of the spell. 
 
Likewise, you may enter the points spent on the spell by clicking on the point value, and 
then typing in a new value. Press TAB or ENTER after you enter the value, and GCA 
will make the appropriate changes, and determine the level based on the points entered. 
 
At the top of the page is a drop-down list. This allows you to change the category of traits 
viewed on the page. The default is ”All Categories.” If you change it to a specific 
category, you’ll only see items belonging to that category in both columns. 
 
At the bottom of the page is a long, thin button with an up-caret icon. This will open and 
close the description area at the bottom of the page. If an item in the Available list has a 
description included, it will be displayed here when you click on it. 
 



Equipment Page 
 
 

 
 
This page allows you to manage equipment items for your character. You can add new 
items by selecting them in the Available Equipment list on the left side, and then clicking 
the Add button in the middle of the page. You can also double-click on an available item 
to add it immediately to the character. 
 
If you select an item in the Character Equipment list on the right, you can remove it by 
clicking the Remove button in the middle of the page. 
 
Some items in the Equipment list appear in blue text. This means the item is getting a 
bonus of some kind – to see exactly what, click on the Edit window. 
 
Near the bottom of the page, on the right side, there is a small group of buttons: the Edit 
button, a small button with a hammer & chisel icon, and an up/down button. 
 
The Edit button will allow you to edit the currently selected item in the Character list. 
You can also call up the edit window by double clicking an item in the Character list. 
 
The button with the hammer & chisel icon is the Modifiers button. It will call up the 
Modifiers window for the currently selected item.  
 
The up/down button allows you to adjust the level of the currently selected item.  
 
At the top of the page is a drop-down list. This allows you to change the category of traits 
viewed on the page. The default is ”All Categories.” If you change it to a specific 
category, you’ll only see items belonging to that category in both columns. 
 



At the bottom of the page is a long, thin button with an up-caret icon. This will open and 
close the description area at the bottom of the page. If an item in the Available list has a 
description included, it will be displayed here when you click on it. 



Templates Page 
 
 

 
 
This page allows you to manage templates for your character. You can add new templates 
by selecting them in the Available Templates list on the left side, and then clicking the 
Add button in the middle of the page. You can also double-click on an available template 
to add it to the character. 
 
If you select a template in the Character Templates list on the right, you can remove it by 
clicking the Remove button in the middle of the page. 
 
There are other icons you may find next to templates in the Character Templates list, as 
follows: 
 

 The trait has missing prerequisites. 

 The template has taboo qualities for this character. (You can see the details in the 
Edit window.) 

 
You may even see two or more icons displayed at the same time. If the taboo icon is 
shown at the same time as another icon, it will lose the circle, and simply have a yellow 
background with the exclamation point. 
 
Near the bottom of the page, on the right side, there is a small group of buttons: the Edit 
button, a small button with a hammer & chisel icon, and an up/down button. 
 
The Edit button will allow you to edit the currently selected item in the Character list. 
You can also call up the edit window by double clicking an item in the Character list.. 
 



The button with the hammer & chisel icon is the Modifiers button. It will call up the 
Modifiers window for the currently selected item. 
 
The up/down button allows you to adjust the level of the currently selected item. 
 
At the top of the page is a drop-down list. This allows you to change the category of traits 
viewed on the page. The default is ”All Categories.” If you change it to a specific 
category, you’ll only see items belonging to that category in both columns. 
 
At the bottom of the page is a long, thin button with an up-caret icon. This will open and 
close the description area at the bottom of the page. If an item in the Available list has a 
description included, it will be displayed here when you click on it. 



Quick View Page 
 
 

 
 
This is a single page where you can view and access nearly every aspect of your 
character, from attributes to equipment. If you haven’t changed the program’s default 
behavior (see Options), GCA will open to this page on start-up. 
 
Along the top of the page is a special toolbar, shown below with the sections highlighted. 
 

 
  
The Traits button shows or hides the traits bar shown on the left side of the page. If you 
close the traits bar, you will have more room to see the character sheet. With the traits bar 
open, however, you can add traits from the bar to the character by double clicking them, 
or by dragging them from the bar onto a white portion of the character sheet. 
 
The Zoom section allows you to zoom in or out of the character sheet. Click on the 
magnifier button with the + to zoom in, or on the magnifier button with the - to zoom out. 
The current zoom factor is shown between them. You can also zoom by double-clicking 
on a blank portion of the page: double right-clicking will zoom out, while double left-
clicking will zoom in. 
 
The Page 1 and Page 2 buttons allow you to change between the first page, which 
includes almost all the traits you can edit, and the second page, which includes just spells 
and equipment. 
 



Most of the page shows the character sheet, of course, as well as other information of 
interest. You can move the character sheet around using the scroll bars, the arrow keys, or 
by clicking and dragging a blank spot of the sheet. 
 
There are a number of boxes on the quick view sheet. With the exception of the Reaction 
Modifiers box, each of these is a field that can be edited. The contents of these fields are 
in red text, a further reminder that they can be edited. (The Reaction Modifiers box 
remains in standard black text, since it cannot be edited.) 
 
If you click inside one of the field boxes, it will turn into a text entry box, which you can 
enter information into. You can close the box by clicking elsewhere, or hitting the Enter 
or Tab keys. 
 
If you enter text for an attribute, such as ST or Per, GCA will calculate the cost for the 
value you entered, and enter it into the points section next to the attribute. 
 
There are also a number of buttons on the sheet. Each button is for a particular trait, and 
clicking it will call up a trait dialog that corresponds to one of the trait tab pages. For 
example, clicking the Advantages button will call up an Advantages dialog. (The dialogs 
are exactly the same as the trait tab pages, discussed elsewhere. The only difference is the 
addition of an OK button, which tells GCA that you’re done with that trait dialog and 
want to return to the Quick View page.) 
 
Below each button is a text area displaying the character’s current traits of that type. 
These traits are in blue text, to let you know that they are a field which you can modify. If 
you click one of the listed traits, it will be replaced with an edit bar, which looks like this: 
 

 
 
The exact appearance of the edit bar will vary, but it will always have fields 
corresponding to the fields shown on the Quick View sheet. 
 
Note that for smaller zoom factors, the edit bar will take up two rows of text on the sheet, 
as shown in the picture above. At higher zoom factors it will fit on one row. 
 
You can use the up/down buttons on the edit bar in the same fashion as on the trait 
windows, to change the level or quantity of the selected trait. 
 
On the left end of the edit bar is the Delete button, which will allow you to delete the 
currently selected trait. GCA will ask for confirmation before actually deleting the trait. 
 
On the right end of the edit bar is the Edit button. Clicking this is the same as clicking an 
Edit button on a trait page – it will call up an Edit window with the current trait 
information filled in. 



 
When you are done working with the item in the edit bar, you can close it by clicking 
onto another item or onto a blank part of the page. 
 



Edit Windows 
 
The various windows here are all used to edit various traits in some degree. 



Edit Items Window 
 
When you first start using GCA, clicking the Edit button in any trait window will bring 
up the Edit Items (Simple) window. Once you’ve been using GCA for a while, you might 
prefer to turn off the Simple window and use the full Edit Items window instead. The 
choice is up to you, but for most of what you do, the Simple window is probably 
sufficient. 
 
Edit Items (Simple) Window 
 
 

 
 
The Simple Edit window allows you to change the name or name extension (the part that 
shows in parentheses) of any trait. It also allows you to change the level of advantages, 
disadvantages, skills, or spells that have levels. You can also set the level by entering it in 
the text box next to the up/down button. 
 
Nothing else on this window can be edited. 
 
For informational purposes, this window also shows you the bonuses currently being 
applied to the trait, what other traits are required by the item (prerequisites, or needs), 



what bonuses are granted by this item, and any modifiers (enhancements or limitations) 
currently applied to the item. 
 
You can access the Full Edit window for the item by clicking the Full Edit Window 
button. 
 
You can access the Modifiers window for the item by clicking the Modifiers button 
(which also has the hammer & chisel icon on it). 
 
Once you have made your desired changes, you can click OK or Cancel, to save or 
discard your changes, respectively. 
 
Edit Items (Simple) Window – Equipment Only 
 

 
 
This version of the Simple Edit window is the same in function as the regular Simple Edit 
window; it allows you to change the name or name extension of the equipment item 
being edited. Instead of entering a level, however, you can enter the quantity of the item. 
Also, this Simple Edit window shows the various weapon statistics, instead of the 
information shown on the other version.  
 
You can access the Full Edit window for the item by clicking the Full Edit Window 
button. 
 
Once you have made your desired changes, you can click OK or Cancel to save or 
discard your changes, respectively. 
 
Edit Items Window 



 
 

 
 
The Edit Items window will allow you to edit many items at once, if you select them all 
before clicking on the Edit button in the trait window. 
 
This window has two viewing modes: Vertical, shown above, and Horizontal. These have 
the same information, but Vertical lists each trait’s information in columns, while 
Horizontal lists it in rows. 
 
The information on this window will differ slightly depending on the trait you are editing, 
and some fields cannot be changed (usually the Points of the item). To make a change, 
click on the field you want to edit, and enter the new information. 
 
Note that you are allowed to change things like Cost, which will alter how the item is 
treated in GCA. It’s possible that a changed trait will no longer comply with the GURPS 
Fourth Edition rules, and may make your character invalid for use in certain campaigns. 
Be sure to consult with your GM before making such changes. 
 
If you have made changes to the trait, and would like to use the customized trait with 
other characters in the future, you can save it to a data file using the Save to Data File… 
button at the top right of the window. Note: Be sure to save the item to your own custom 
data file, and not one of the official files, because the official files will be over-written 
when they are updated. If you don’t yet have a custom data file, pick a name in the Save 
dialog when you click the Save to Data File… button, and GCA will create it for you. 
Also, remember that you’ll need to tell GCA to load your custom data file if you want to 



use it in the future, so you’ll need to visit the Data Files tab in Options to include your 
file in the correct data set. 
 
You can add, edit, or remove modifiers for the currently selected trait by clicking on the 
Modifiers button at the bottom of the window. 
 
You can raise or lower the level of the currently selected trait by clicking the up/down 
button next to the Modifiers button. If the trait has only one level, you will not be able to 
change it. 
 
The Advanced… button calls up the Edit Item Advanced window. This provides even 
more access to trait properties, and using it could create an unusable item. 
 
The Add Tag button is another advanced feature, allowing you to add additional 
properties to the trait (called tags in GCA parlance). In general, GCA ignores tags that it 
doesn’t understand, so you can use the Add Tag feature to create custom data fields for 
your own personal projects. 
 
A quick rundown on some of the tags: 
 
Cat: How the traits are categorized. Categories are used in many ways within GCA, 
including granting certain kinds of bonuses and printing in certain areas on the character 
sheet. 
 
Cost: The cost progression for the trait. If the cost is listed as cost/cost, then the item has 
at least two levels, possibly more. (Affliction, for example, has a listed cost of “10/20”; 
10 points for one level, 20 points for two.) 
 
BonusLevels: The number of levels the trait is getting as a result of any bonuses being 
applied.  
 
Upto: The maximum number of levels that can be purchased for this trait. 
 
Needs: Any other traits this trait requires. 
 
Taboo: Any other traits that are considered taboo to this one. 
 
TabooText: The taboo traits this character currently has. 
 
Gives: Any bonuses this trait gives to other traits. 
 
BonusList: Any bonuses that are currently being received by this trait. 



Edit Item Advanced Window 
 
 

 
 
This is an advanced feature of GCA, and you should usually not have any reason to use it. 
Only the more advanced users of GCA should do anything with the tags available here, 
because it is possible to alter an item to make it unusable in GCA. It’s also possible to 
create data here that will crash GCA. 
 
This window allows you access to all the tags that currently exist for a particular trait. 
Only tags that are used by the particular trait being edited are listed here, in alphabetical 
order. A trait without a name extension will not display it on this listing. 
 
If you wish to add a tag in this window, even a common one such as Name Extension, 
you must use the Add Tag button to get to the Add Tag window. 
 
You can use the Remove Tag button to delete any tag displayed. 
 
Note that it is possible for you to edit all available tags, even those that GCA will simply 
recalculate anyway. In those cases, GCA’s calculations will take precedence. 



Modifiers Window 
 
 

 
 
The Modifiers window allows you to add, edit, and remove modifiers that apply, or can 
be applied, to the current trait. 
 
The trait you are applying modifiers to is shown in bold at the top of the window, just 
above the categories drop down list. 
 
Many traits have groups of modifiers that apply specifically to them. In such cases, those 
categories automatically fill the Available Modifiers list. Modifiers that are already 
applied to the trait are in the Character Modifiers list. 
 
In most respects, this window is just like the various trait pages. You add new modifiers 
with the Add button, remove them with the Remove button, and adjust them with the 
up/down button. Likewise, you can edit the currently selected modifier with the Edit 
button. You can even add modifiers to the current modifier with the Modifiers button 
(with the hammer & chisel icon). 



Edit Modifier Window 
 
 

 
 
This window is very similar to the Simple Edit window for traits. It allows for changing 
the name of the modifier, as well as the level for leveled modifiers, but not much else. To 
edit the full set of tags available to modifiers, you would click on the Full Edit Window 
button, which calls up the same Edit Item Advanced window that you’d use for advanced 
editing of traits. 



File Windows 
 
The various windows here call all be opened from the File menu. 
 



Template Options Window 
 
When you save a character as a template, you’ll see this window before the template is 
saved. (You can save a character as a racial template by selecting “Template within Data 
File (*.GDF)” in the “Save as type:” box of the Save File As dialog.) 
 

 
 
This window allows you to choose the options related to saving your character as a racial 
template. After you click OK, you’ll be presented with a standard File Save dialog to 
select the file to which your template will be saved. 
 
The options available here are: 
 
Owns: Turning this option on makes the racial template own the component traits that 
make it up. When a trait owns its components, the costs of those owned traits are 
included in the cost of the template, and are not considered independently for any other 
purpose. (This means that disadvantages that are part of the template reduce the cost of 
the template, but aren’t themselves counted against any disadvantage limit.) 
 
Locks: Turning this option on is what prevents the user from being able to change the 
component traits within GCA. When components are locked, they can be disabled (from 
the right-click menu), but they can not be removed or edited in any other way. 
 
Hides: Turning this option on is what normally hides the components from the user 
within GCA. Hiding the components is considered beneficial to reduce the clutter of traits 
on the character sheet, since the components are wholly contained within the template. 
Many users like seeing all the component traits, however, and dislike having them 
hidden. (You can show hidden traits appropriate to the various trait pages with the right-
click menu: select Show, then Show Hidden Items. This will not work on the Quick View 
page.) 



 
Use adds() when possible, instead of creates(): This option includes a bit of technical 
jargon, but it’s referring to the two ways that GCA handles template items. 
 
Adds() items are added to the template based on finding the named item in the Available 
list of the appropriate trait page. This would be the same way that you added most traits 
to the character that you’re saving to the template. This option is actually preferred, 
because it means that the most current version of the trait is included when the template is 
added to the character, even if it includes errata or corrections. However, if the trait is not 
found at all, it can’t be added to the character. 
 
Creates() items are added to the template as if you’d created them from scratch using the 
editing options within GCA. This option ensures that all the traits are added to the 
character when the template is taken (even if they don’t exist in the current Available 
lists), but it adds them exactly as they existed when the template was created, so if there’s 
an updated version of the trait, the version added by the template will not be correct.  
 



 

Export Options Window 
 
 

 
 
This window allows you to choose the options related to exporting your character to 
another format. 
 
The Character Sheet for Export… box allows you to select the character sheet to use for 
the exporting of your character. The default export filter sheet is shown, but others are 
included with GCA. 
 
The Output Format… box is where you select the type of file you want the export to be. 
The options here should be self-explanatory. 
 
The Custom… box is for when you’re using a custom export filter that that might export 
a type that isn’t included in the Output Format… box above. You can specify this option 
to reduce the amount of interference GCA may apply to your export, and you can specify 
a custom file extension as well. 
 



The XML… box is a bit different, because it doesn’t use the sheet you selected in the 
Character Sheet for Export… box. Instead, it simply outputs all of the character data to a 
file in XML format. 



View Windows 
 
The various windows here can all be opened from the View menu. 



Appearance Window 
 
 

 
 
This is a simple window allowing you to enter your character’s race, height, weight, and 
age, as well as a short description of his appearance. (Your character’s race may also be 
set or changed by selecting certain templates.) 
 
Note that all of these entry areas are for simple text – GCA will not do any formatting for 
you. This way, if you want to record height in feet or meters, or weight in pounds, stone, 
or kilos, it’s up to you. 



Campaign Log Window 
 
 

 
 
This window allows you to keep a log of events in your character’s life. It also allows 
you to track character points earned during gaming sessions, or from other sources. 
 
The log entries are listed at the top of the window. Clicking on an entry will display the 
information and notes in the two text boxes below it. You can change the date and points 
earned values directly inside the list by clicking on the value you want to change and 
entering a new one. 
 
You can add an additional point value in the Other box on the right side of the window, 
below the OK and Cancel buttons. 
 
Your total character points earned will be updated as you change values in the log or in 
the Other box. 



Campaign Settings Window 
 
 

 
 
This window allows you to set the campaign-specific values for base character points, 
and points allowed for disadvantages and quirks. 
 
You can also set the Base Tech Level for the campaign here. If you do this, any /TL skills 
you select will automatically be assigned that tech level (or the closest one possible). 



Description/Notes Window 
 
 

 
 
This is a text window used for two types of information: 1) character descriptions, 
including property, pets, friends, etc.; 2) notes about anything related to your characters. 
 
You can switch between the text boxes with the tabs at the top of the window. 
Description and Notes both have entries on the View menu. Selecting either one will 
bring up this window, open to whichever one you selected. 
 
The text editing area in the middle of the window is an RTF editor; you can select 
different fonts, use bold or italics, etc. You can even copy and paste text out of other 
programs, including Microsoft Word and many others. Most text formatting should be 
preserved when it’s pasted into this window. 
 



Load-Out Manager Window 
 
 

 
 
The Load-Out Manager window allows you to specify different types of equipment 
configurations, called “load-outs,” for your character, and to specify which of those 
you’d like used to calculate the encumbrance load on the character sheet.  
 
At the top of the window are the New… and Delete… buttons. The New… button allows 
you to create a new load-out, and to name it. This will make the new load-out the active 
one, and will clear the check boxes from the list. The Delete… button will delete the 
current load-out (it will ask for confirmation). 
 
Below the buttons is a drop-down list showing the currently selected load-out. This is the 
active load-out that will be modified as you change items in the list. 
 
In the middle of the window is the equipment included in the current load-out. Any item 
marked with a check box is included, while those not marked are not included. Click on 
the check box in order to add or drop a piece of equipment from the current load-out. (To 
the right of the listing it shows the number of items of each piece of equipment and the 
weight of that item, or group if more than one is included.) 
 
On the right side of the window, next to the equipment selection area, there are two 
displays: Load Weight, which shows the total weight of the items included in the current 



load-out; and Enc. Level, which shows the encumbrance level of the current load-out for 
your character, if he was carrying everything listed. 
 
Below the equipment list are two buttons allowing you to quickly select or de-select all 
the items in the equipment list. 
 
At the bottom of the window is a drop-down list for selecting which load-out to use to 
figure encumbrance for your character. (If you select <All Unassigned Items>, GCA will 
assume that all the equipment not otherwise assigned to a load-out is to be figured into 
encumbrance.) 
 
The displays at the bottom right of the window show the weight of the selected load-out, 
as well as the encumbrance level. 
 



Portrait Window 
 
 

 
 
The Portrait window allows you to select a picture for your character portrait. It supports 
a variety of formats, including BMP, JPG, IMG, EPS, and PNG formats (but not GIF). 
 
Click the Load button to bring up a standard Windows file browser to select the picture 
you want. 
 
Click the None button to clear the portrait. This will leave the portrait area on your 
character sheet blank. 
 



Protection Window 
 
 

 
 
The Protection window allows you to set DR values for different areas on your character, 
or to set Active Defenses. 
 
At this time, GCA does not automatically assign DR values based on your character’s 
equipment. 
 
In the Body Protection box a the top left of the window, the DR Bonus and DB Bonus 
fields at the top show you the whole-body bonus that should be applied in addition to any 
armor or shield values. These values will come from traits such as the Damage 
Resistance advantage, which adds a DR bonus. 
 
Also within the Body Protection box are two text boxes that allow you to enter notes 
about other DR or DB sources that may affect your character, but that don’t get figured in 
normally.  
 



To set Active Defenses, choose a skill from one of the drop-down lists. Skills that are 
available will be listed, along with their level, and their Parry or Block score. 
 
You can set DR values using the body diagram on the right side of the window. (You can 
also enter DB values there, but usually you won’t need to do that.) Click on the value you 
want to change, and enter the new value. 
 
Alternatively, you can use the Apply Armor tab at the top left of the window, and select 
from the various pieces of armor your character currently has. You can check the items 
you want to apply to the character, and GCA will fill in the appropriate armor values. 
 

 
 
Note: At this time, GCA does not understand how to combine different armors correctly, 
so it doesn’t even try. If you click on two items that both provide armor for the same area, 
GCA will list both of them, separated by a + sign, signifying that you should add them 
together. Unfortunately, this means that more than a couple such values will run off the 
edge of the available space for that body area, and no longer be visible. 
 
In addition to the body areas listed on the picture, GCA supports a large number of 
different areas, both of more detail, and less detail. If you click the tall, thin button in the 



middle of the window, GCA will adjust the window to show the All Body Parts Available 
property list, as shown below. 
 

 
 
On the property list, you have control over which body areas you want to display on the 
picture (although you’ll have to manually position them using the X, Y properties, and 
swich Display to True or False, as appropriate). 
 
You can also adjust the values for protection areas that might not display on the picture. 
Note that if you change the value for a larger area, such as Full Suit or All, GCA 
automatically trickles the value you enter down to all other areas covered by that area. In 
this way, you can set the value for Arms, and both the LeftArm and the RightArm will 
automatically get assigned the correct value. 
 
The property list also allows you to adjust the Base DR, DB, and HP values. The Base 
DR value is important, because it becomes the baseline for body protection when you use 
the Apply Armor tab to set armor values. The Skull has a Base DR of 2, so GCA knows 
to always start with 2 when applying armor to the Skull. If your character has additional 
natural armor for other parts, you may want to set the Base DR value for them. 
 



Logging Window 
 
 

 
 
This window provides GCA with a means of communicating to you, to provide 
information that may be useful at times, but which would be very annoying if GCA 
constantly popped up message boxes to keep you informed. 
 
If GCA encounters a problem, it usually logs it to this window, although a critical error 
may still pop up a message box, also. 
 
You may close the Logging window if you wish, and GCA will still operate correctly. 
You simply won’t be alerted to a number of issues that may arise. 
 



View Info Window 
 
 

 
 
This window allows you to view a greater amount of information about the currently 
selected traits in the Available list of your current trait page. Most of the pertinent 
information you might be interested in will be displayed here. 
 
If you select multiple traits in the list, information about each of them will be displayed 
here, separated by a dashed line, in the order they appear in the Available list. 
 
This window will stay open as long as you need it. 
 



Tools Windows 
 
The windows available here can be opened from the Tools menu, or from the Options 
window. 



Resynchronize Window 
 
 

 
 
This window allows you to resynchronize some or all of your character with data 
included in the currently loaded data set. 
 
When you click OK, GCA goes through the character and tries to match up every trait 
there with one from the system lists (as shown in the Available lists on the trait pages). If 
it finds a match, it will copy the information from the system item into the character item 
(preserving the character’s version’s name and certain required info, such as points spent 
or levels bought). 
 
This tool is essential for updating all of a character’s traits at one time, rather than having 
to remove and re-add various traits in order to update them with newer information 
available in an updated data file. 
 
(GCA stores all the needed information for a trait with the character, so that the character 
can be viewed and edited correctly even if the data files used to create that character are 
not available. This means, however, that updated data in a data file will not automatically 
be applied to the character the next time you load it up. The only way to get the updated 
data into the character is to resynchronize.) 
 



Find Traits Window 
 
 

 
 
This window allows you to search for traits, if you aren’t sure of their name, or you can’t 
seem to find them where you expect them to be. Once you’ve found the traits you want, 
you can add them to your character from this window, rather than having to go to the 
related trait tabs first. 
 
(Note that at this time, GCA only searches traits based on their names.) 
 
The primary features are the “Text to find:” box, where you type the text that you want to 
find in the trait lists; and the list box containing the results. 
 
You can use the “Look in:” drop-down list to limit the search to a particular kind of trait. 
 
If you find the traits you want, check the boxes for them, and you can then click the Add 
To Character button to add them directly to the character. 
 
You’ll note that there are two options at the top of the window: Simple Search or RegEx 
Search. With the limited search capability currently included (names only), the RegEx 
search is probably not necessary. If you do use the RegEx Search, your "Text to find" 
will be the regular expression used for matching against the trait names. If you don't 
understand what regular expressions are, you should probably stick to Simple Search for 



now (or do an Internet search for a tutorial on regular expressions). In Simple Search, the 
text entered into the "Text to find" box is matched exactly against the trait names. 
 
The regular expression syntax recognized by GCA is based on the following special 
characters: 
 

Char Description 
^ Beginning of a string. 
$ End of a string. 
. Any character. 
[list] Any character in list. 
[^list] Any character not in list. 
? Repeat previous zero or one time. 
* Repeat previous zero or more times. 
+ Repeat previous one or more times. 
\ Escape next character. 
 



Character Sheet Options Window 
 
 

 
 
This window provides you with the ability to set preferences for the various character 
sheets available for GCA. (The character sheet must be written to support the use of 
options.) 
 
At the top of the window is the Character Sheet drop-down list, which you can use to 
select the sheet for which you’d like to set options. (When you first load this window, the 
Options section below will be blank.) The sheets presented in the drop-down list are from 
your current character sheets folder. If you have sheets stored in more than one location, 
or you’re not sure where your preferred character sheet is located, you can click the 
Browse… button to open a dialog allowing you to browse to your file. 
 
Once you select a sheet, any options available for that sheet will appear in the Options 
frame below. You will then be able to change the options that interest you. 
 
Below the sheet selection drop-down are two option buttons that allow you to specify 
whether you’d like to work with options in one long list, or broken into sections. The 
window pictured above is using one long list, and you can see the scrollbar on the right 
side of the Options area that will allow you to scroll down and work with all the options 
available for the sheet. 



 
If you select the “By sections” option button, GCA will break the options listing up into 
the sections specified by the sheet author, and present them to you in smaller blocks, as is 
shown below. 
 

 
 
In this version of the window, you can see that there is now another drop-down list, this 
one at the top of the Options section. This list holds the names for each section of options 
available for the sheet, and changing it will change the options shown in the rest of the 
Options box. 
 
If you wish to reset all of the various options to the default values for the sheet, you can 
click the Reset to Defaults button. This affects all options for the sheet, not just the 
options that you may be working with at the moment. 
 
There are a variety of different option types available in the Character Sheet Options 
window, but which ones you see for any particular sheet depends on what options the 
sheet author needed to address. Here are the different types of options you might see. 
 
Yes/No: The Yes/No option allows you to set a yes or no preference for a particular 
option. You may also see this as a True/False option, but it works the same way. To set 
your preference, simply click on the option button that represents your choice between 
Yes or No. 
 



 
 
Text: The Text option allows you to enter some text for the option. The Text option will 
allow you to enter almost any type of plain text, but the sheet may ask you to limit it in 
some fashion in order to work as the sheet intends. 
 

 
 
Color: The Color option allows you to select a color. The current color is displayed in 
the color swatch, and the hex value of that color is shown in the text box. You can change 
the color by clicking the rainbow button to open a standard Color dialog. (Note that the 
VBScript language used by character sheets in GCA uses a reverse order for the hex color 
codes, which may be confusing if you’re used to setting colors by that method.) 
 

 
 
Font: The Font option allows you to select a font. The name of the selected font is 
displayed in the font box. You may change fonts by clicking the ABC font button to open 
a standard Font dialog. 
 

 
 
List: The List option presents you with a drop-down list filled with the available options, 
from which you select one. 
 

 
 
Check List: The Check List option allows you to select a number of items from a 
provided list. You check the items you want to select. 
 

 
 
Ordered List: The Ordered List option presents you with a list of possibilities that you 
can rearrange to suit your preference. You can rearrange the items in the list by selecting 
the ones you wish to move, and then clicking the arrow buttons on the right side to move 
the selected items up or down in the list order. 
 



 
 
 



Options Window 
 
 

 
 
The Options window allows you to set options in several different areas. You can move 
between the areas in the Options window by selecting the appropriate tab at the top of the 
window. 
 
If your window isn’t big enough, you may have to scroll down to see some of the options 
in certain areas. 
 
Note that for certain options, GCA can load some settings from data files, so the available 
options may be changed once a data file is loaded. 
 
Data Sets Tab 
 
 



 
 
This tab lets you select a data set. Note that a set selected here will not be active until the 
next time GCA is loaded, or you click the Load Now button at the bottom of the tab. 
 
The Current Data Set drop-down list has all the data sets available from the current data 
set folder. When you select a data set here, all the data files that it includes will be listed 
in the Data Files Included list box. 
 
If you want to change to a different folder, or create a new data set, you can click the 
Change… button to load the Data Sets window, which gives you more complete control 
over building and using data sets. 
 
The Change & Load Files… button allows you to quickly change the data files assigned 
to the current set. Clicking it calls up the Change Loaded Data Files window. When 
you’re done with the Change Loaded Data Files window, GCA will automatically reload 
the data files you specified there, so you’ll be ready to continue using GCA with those 
files. 
 
Program Options Tab 
 
 



 
 
The Program Options tab allows you to set the majority of the preferences available in 
GCA. You’ll have to scroll down to see most of the available options. 
 
The various options available are broken down into logical groups, so we’ll cover them 
that way here. Note that the default state of each option is shown in the accompanying 
images. 
 

 
 
Choose Data Set at start-up: If you turn this on, you will be presented with the Data 
Sets window when GCA first starts up, before it loads any files. This is a convenient way 
to make sure you’re working with the right set if you use several different data sets on a 
regular basis. 
 
Check for new data files on start-up (only if not choosing Data Set): This option will 
have GCA check for newly added data files (only to the default data files folder, though), 
and notify you if it looks like you have some. If you currently have Choose Data Set at 
start-up turned on, this option will do nothing. 
 
Load a new character on start-up: This option determines whether or not GCA should 
create a new character when it loads. If you’re frequently editing existing characters 
rather than creating new ones, turning this off can be a time-saver. 
 



Open Campaign Settings when a new character is created: This option tells GCA that 
you want to have the Campaign Settings window appear every time you create a new 
character. This allows you to easily set Tech Level and starting character points before 
you begin. 
 

 
 
Use large toolbar buttons: With this option checked, GCA uses the larger 24x24 toolbar 
button images. Unchecked, GCA will use the smaller 16x16 images. 
 
Show Toolbar: This option allows you to select your preference from the drop-down list, 
so you can have the toolbars display at the top of the window, at the bottom of the 
window, or not display at all. 
 
Show Character Tabs: This option allows you to select your preference from the drop-
down list, so you can have the character tabs display at the top of the window, at the 
bottom of the window, or not display at all. 
 
Show Trait Tabs: This option allows you to select your preference from the drop-down 
list, so you can have the trait tabs display at the top of the window, at the bottom of the 
window, or not display at all. 
 
Show category drop-down list on … tab: These options are all the same, and determine 
if you want to have the category list displayed at the top of the related tab page. 
 
Multi-line Available items: This option will allow the name of items in the Available 
trait lists to wrap to multiple lines, if necessary. This can be convenient at times, but since 
it also hurts how the lists look, it’s an option. 



 
Show Modifiers button next to Edit button: This option allows you to choose whether 
to display (or not) the Modifiers button (with the hammer & chisel icon) on all trait 
windows.  
 
Use Quick View as primary tab: This option lets you choose whether you want the 
Quick View tab to always pop into view when you’re starting GCA, and to keep it around 
for use the rest of the time. 
 

 
 
Use Simple Edit window: This option allows you to turn off the Simple Edit window if 
you prefer the full Edit Items window. 
 
Allow marking items for the GM control sheet on Simple Edit: This option allows 
you to turn on a check box that will appear on the Simple Edit window, which will allow 
you to mark items for inclusion on the special GM Control Sheet character sheet. 
 

 
 
Disable auto-recalculation of traits: This option allows you to turn off GCA’s ability to 
automatically recalculate traits that might be affected by changes to other traits. If you 
find GCA runs too slowly on your machine, you may elect to turn on this option, and 
periodically choose Recalculate Everything from the Tools menu, instead of having GCA 
calculating things for you as it would normally. 
 
Disable auto-calculation of secondary trait features: This option allows you to turn off 
GCA’s ability to automatically calculate such features as damage, range, parry, block, 
and a wide variety of others, for the traits that have them. If you find GCA runs too 
slowly on your machine, you may elect to turn on this option, but we suggest trying the 
“Disable auto-recalculation of traits” feature, instead. 
 
Show bonus text for bonuses from a trait (or its modifiers) to itself: This option is a 
bit odd, but in most cases you’ll want to leave it turned off. GCA has the ability to list all 
changes to the baseline status of a trait. This means, for example, that if you add a 
modifier that improves the range of an item, GCA can include that adjustment in the list 



of bonuses the item receives. Turning on this option causes that to happen. Most people 
simply find the extra information confusing, so it’s not included by default. 
  

 
 
Add skills at minimum cost: This option causes newly added skills to be added to the 
character with the minimum point expenditure required. If you’d prefer to be able to add 
skills at the 0-point level, turn this option off. 
 
Auto-add prerequisites: This option has GCA try to add any prerequisite items for a 
trait to the character automatically when that trait is taken. Turning this option off can 
make adding spells, for example, take a lot longer. 
 
Upto affects points: This option limits the points that can be spent on traits, usually 
techniques, with “upto limits” that prevent the trait from actually being raised to a higher 
level. If this option is turned off, it may be possible to spend additional points on the trait 
that do not actually result in a change in level. 
 
Allow decrementing to level zero: This option allows you to drop the level of 
advantages, perks, disadvantages, and quirks to level 0 without them disappearing from 
your character sheet. This is convenient when you want to see what effect not having that 
trait will have on your character, without actually removing it. It’s also handy to serve as 
a reminder that you might be working toward obtaining that trait some day. However, 
allowing this as standard behavior is often confusing to new users, so it is turned off by 
default. 
 

 
 
Use Dice+Adds conversion: This option enables the use of the optional rule to convert 
large damage bonuses into dice, instead. The default rule is to convert +7 into +2d, and 
+4 into +1d. 
 
Rule of: This option allows you to adjust the maximum attribute value used for skills that 
are defaulting from an attribute. 
 



Use multiplicative percentage modifiers: This option instructs GCA to use the optional 
rules for multiplicative percentage modifiers. 
 
Allow optional specialties for non-IQ based skills: This option instructs GCA to allow 
skills not based on the IQ attribute to also be used to create optional specialties. 
 

 
 
Group child items by type: This option instructs GCA that you want items that you 
make into children to be grouped with other items of similar type (advantages with 
advantages, skills with skills, etc.), before sorting them in any other way. 
 
[Sorting Dropdown List]: This drop-down list allows you to specify it you want child 
items sorted ascending, descending, or not at all. 
 
Sort by name, Sort by points, Sort by tag: You can select only one of these options, 
and if you select “Sort by tag”, you’ll need to specify the tag on which you’d like the 
child items sorted (could be name, tl, etc.) 
 

 
 
Save RTF text blocks as plain text instead: This option provides a way for you to “un-
RTF” the normally RTF text blocks in GCA. This simplifies the saved character file if 
you are posting it to a web site or have another use that gets confused by blocks of RTF 
text. It also simplifies the text blocks if you simply prefer to have the affected text blocks 
be unformatted. 
 
Maintain persistant FastLoad files: This option helps ensure that GCA loads as quickly 
as possible, when you’re using a data set that you’ve used before. If you turn this off, 
GCA will not save the FastLoad data when it shuts down, and it’ll have to rebuild it the 
next time you use that data set. Leaving this option on will consume more disk space, 
however, than turning it off. 
 



 
 
This block isn’t a normal option, but instead allows you to reset the file associations GCA 
uses to automatically run and load particular files when you double-click them in 
Windows. 
 
Default Character Options Tab 
 

 
 
This tab allows you to set a few character-specific things for characters you create in the 
future. Changes you make will affect only the characters you create in the future, not any 
existing characters. 
 
You can set the default Player Name, as well as the default point values and TL 
suggested for future characters. 
 
You can also set the default character sheet, and the alternative character sheets, you want 
available for future characters (these appear on the Print and Print Preview drop-down 
lists on the toolbar). For both the character sheet and the alternative sheets, the sheets you 
select here will become the default sheets for new characters you create in the future. Use 
the Add… button to choose sheets, and they will appear in the list box. If you wish to 
remove a sheet, select it and click the Remove button. 
 
Current Character Options Tab 
 
 



 
 
This tab allows you to set specific options for the currently loaded characters. 
 
You can choose which character to apply settings to by selecting them in the Current 
Character drop-down list, before making changes to the other options. 
 
You can adjust which character sheet should be used for the character by default, as well 
as setting the alternative sheets. All selected sheets are available from the Print and Print 
Preview drop-down lists on the toolbar, but the Character Sheet setting is the one that will 
be used automatically if you simply select Print or Print Preview. 
 
Use the Add… button to choose alternative sheets, and they will appear in the list box. If 
you wish to remove a sheet, select it and click the Remove button. 
 



Data Sets Window 
 
 

 
 
This window allows you to choose new folders for data sets and data files, and to create 
new data sets. 
 
At the top of the window is the current folder GCA is searching for data sets. You can use 
the Browse… button next to it to open a window to browse for a new folder. 
 
Next is the Current Data Set, which is displayed in bold. This shows the data set that 
GCA is currently using, or planning to use. If you want to create a new data set, click the 
New… button, give it a name, then move to the next section to select data files to include 
in the data set. 
 
Below the Current Data Set field is a list of Available Data Sets. This is a list of all the 
data sets GCA found in the current folder (as shown at the top of the window). You can 
click on a data set here to make it the Current Data Set. 
 
Below the list of available data sets is the Current Folder for Data Files. This does not 
have to be the same as the current folder for data sets. You can change this folder by 
clicking the Browse… button, or by changing folders in the Available Data Files list 
below. 



 
At the bottom of the window are the sections for Available Data Files and Included Data 
Files. 
 
Available Data Files is a list of all the files available in the current folder (as shown just 
above). It also shows any folders available from the current folder, and allows you to 
back up to the parent folder. If you change folders here, it will be reflected in the current 
folder above. 
 
Next to the Available Data Files list is the Included Data Files list. This list shows what 
data files are actually included in the Current Data Set. You can change what order they 
are loaded in by selecting files and using the arrow buttons immediately to the right. Files 
at the top of the list are loaded first, and files at the bottom of the list are loaded last. Note 
that files loaded later will replace duplicate items, so normally you’d want to load newer 
files later. 
 
Below the Included Data Files list are the Add and Remove buttons. You can use the Add 
button to add data files selected in the Available Data Files list to the Included Data Files 
list. You can use the Remove button to remove selected files from the Included Data Files 
list. 



Change Loaded Data Files Window 
 
 

 
 
This window provides a simpler means of changing and loading the data files included in 
the current data set then first using the Data Sets window and then clicking Load Now. 
 
This window has the familiar Available list of data files on the left, and the Included data 
files on the right. The data set for which you’re changing files is noted at the top of the 
window in bold. 
 
When you click on a data file in the Available list, any description included in the file 
will be shown in the text box below the lists. 
 
When you are done changing the data files included in the set, click OK to close the 
window and immediately load the new set into GCA. 
 
If you find yourself changing data files periodically using this window, then you should 
probably be using the Data Sets window to create new data sets, instead. Switching 
between previously created data sets is generally faster and more convenient then 
constantly changing the data files you’re loading. It’s also less prone to you forgetting to 
load a data file that you need. 
 
As with all data file or data set changes, remember that changing data files will not have 
any impact on traits already added to existing characters.  
 



Party Windows 
 
The windows available here can be opened from the Party menu. 



 

Add Party Log Entry Window 
 
 

 
 
This window allows you to quickly and easily add an entry to the Campaign Log of all 
currently loaded characters. Simply enter the information you wish posted, and click the 
Post Entry button. 
 
The data fields here are the same as found on the Campaign Log window. As with the 
Campaign Log window, the Notes field supports RTF, so you may paste in formatted text 
from most Windows word processing programs, and have most of the associated 
formatting preserved. 
 



Help Windows 
 
The windows available here can be opened from the Help menu. 
 



About GCA Window 
 

 
 
This window provides you with the basic copyright information for GCA, as well as the 
same links to web content that you’ll find on the Help menu. 
 
At the bottom of the window, immediately to the left of the cover image, is the current 
version of GCA. 
 
A version of this window also pops up when you start GCA. This version of the window 
is often referred to as a “splash screen” for the program. That version does not have the 
OK button, and will disappear automatically once the rest of GCA has loaded. 
 



Credits Window 
 
 

 
 
This window provides information about the credits for GCA, much as you’d find inside 
any GURPS game book. (Interestingly, there is no credit for the writing of the document 
you’re currently reading.) 
 



Other Windows 
 
The windows here appear when needed by GCA, are aren’t specifically called up by the 
user. 
 



 

Select Items Window 
 
 

 
 
This window will appear only when you’re working with some character templates. It 
provides a window that works very much like the trait pages, but the Available lists are 
limited to specific sets of items available for use with the template. 
 
You’ll notice that the standard Add, Remove, Modifiers, Edit, and up/down buttons are 
all available here, and can be used in the same way as on the trait pages. 
 
Of particular interest is the text found under the OK and Cancel buttons. This text 
informs you as to what choices need to be made to satisfy the requirements of the 
template, and whether you’ve met them. If the text is red, you have not yet met the 
requirements, and the OK button will remain disabled. 
 
In the example above, the user must take one or more items from the Available list, 
totaling exactly 15 points, in order to satisfy the requirements. Once this has been done, 
the OK button will be activated, and the processing of the template can continue. 
 
You will often be provided with a number of Select Items windows in succession, as the 
template specifies, to select the various traits for the character. You can cancel the adding 
of the template at any time during this process by clicking the Cancel button on any 
Select Items window. 
  



TUTORIAL 
 
This section of the help system is the Tutorial, and instructs the user in working with 
GCA. This section does not cover all the features of any part of GCA, only the features 
necessary to accomplish particular tasks. 
 



 

Part One: Getting Started with GURPS Character 
Assistant 
 
The first thing you’ll see when you start up GCA is a pair of windows: the Logging 
Window and the Splash Screen. 
 
The Splash Screen welcomes you to the program, and links to some useful websites. It 
looks like this: 
 

 
 
The “Check For Update” link will check to see if you have the most current version of 
GCA, and let you download any needed updates. 
 
The Logging Window tells you what GCA is doing during loading, and will give you 
messages from the program from time to time. It looks like this: 



 
 
You may see messages about program status, or even problems GCA has encountered. 
 
If this is really the first time you’ve run GCA, you may also see another dialog box pop 
up: 
 

 
 
This dialog will appear any time GCA sees new files in the default data files folder. Since 
GCA has never seen any files there, it will ask the first time you run GCA, and you’ll 
have the opportunity to load additional data files if you wish. 
 
Let’s click Yes this time, to see the window that pops up. (If you click No or Cancel, 
GCA will continue on with the normal process of loading the default data file for GURPS 
Fourth Edition.) 
 
If you clicked Yes, you’ll see a window appear that looks like this: 
 



 
 
This is the Change Loaded Data Files window, and it allows you to change the data files 
that you’re loading for the current data set. (Don’t worry about data sets yet, we’ll cover 
that elsewhere.) If you were planning to create a character that needed information from 
another GURPS book, then you’d be able to add the data file for that book to the Included 
Data Files list and load it now. This time, however, let’s just click OK to continue on 
with loading just the default GURPS Basic Set 4th Ed.--Characters.gdf file. 
 
Once GCA has finished loading the default data file for GURPS Fourth Edition, the main 
GCA window will appear, and a new character will be created automatically. Once GCA 
begins, a Campaign Settings window will pop up for you to fill in for the new character. 
The main window with Campaign Settings dialog box will look like this: 
 



 
 
After you type in the appropriate values, click OK to begin working on your character. If 
you make a mistake or need to change one of the settings later, you can make the change 
with the Campaign Settings dialog box from the View menu, as shown here: 
 



 
 
Moving on, let’s look at the main window that you’ll be starting with once you’ve clicked 
OK in the Campaign Settings dialog. This is the Quick View window, and it looks like 
this: 
 



 
 
This is actually a bit cramped for our tutorial, so let’s make some more room for us to 
work with. (You can simply resize your GCA window to make more room, but our screen 
shots need to stay fairly small, so we’ll demonstrate some of the other things you can do 
to save screen space.) 
 
First, let’s use the toolbar handles to move our second toolbar up next to the first, to free 
up some vertical room. The toolbar handles are shown here: 
 

 
 
On the second toolbar, click and drag the toolbar handle to just after the last image on the 
first toolbar. When you’re done, the toolbars should look something like this: 
 

 
 
Now, let’s clear up some horizontal room by closing the traits bar on the left side of our 
window. Don’t worry, we’ll come back to the traits bar later. 
 



Find the Traits button on the button bar for the Quick View window. It’s next to the zoom 
buttons, as shown here: 
 

 
 
Click the Traits button, and it should no longer be highlighted. At the same time, the 
traits bar down the left side of the Quick View should go away. 
 
That’s more like it, now we’re seeing a lot more of the data on the window. We want to 
see just a bit more, though, so we’re going to also click the minus magnifier button in the 
Zoom area, in order to see a bit more of the page. GCA should now look something like 
this: 
 

 
 
Now we’re ready to talk a bit more about this window. 
 
The Quick View window is a handy way to look at a character sheet. You can drag the 
page around by grabbing a blank area with your mouse and dragging it, or by using the 



arrow keys. You can also zoom in or out by double-clicking a blank area with the left or 
right mouse buttons, respectively. 
 
The character sheet is full of boxes and buttons. The boxes contain fields, most of which 
you can edit directly. If the text in a box is red, you can click on that box to edit it. The 
attributes and secondary characteristics are also in red, as is the name of the character. 
The only box on this page you can’t edit is Reaction Modifiers. 
 
Click on some of the boxes, and enter some values. If you click on an attribute box, 
you’ll see GCA calculate the point cost for the score you enter. If you enter a score that’s 
not legal, GCA will adjust it to a score that is allowed. 
 
Now, try clicking on the Advantages button, to open the Advantages dialog. That looks 
like this: 
 

 
 
(You may want to grab an edge and make the dialog a bit larger than it originally appears, 
so you can more easily read the advantages that are available.) 
 
All the advantages available are listed on the left side, and all the advantages you’ve 
taken already will appear on the right side. Since we just started, there aren’t any 
advantages to list yet. If you want to look at a smaller listing of traits, you can use the 
drop-down list at the top to select limited categories of items. This will limit what is 
displayed in both columns, so remember to set it back to “All categories” to see 
everything your character has. 
 
In the middle are buttons to let you add traits from the Available column to your 
character, or to remove them from your character. 



 
Notice the icon that looks like a wrench that’s next to many of the available advantages, 
including the Affliction advantage. That wrench tells you that GCA will require some sort 
of input from you before you’ll be able to finish taking that item. 
 
Let’s add Affliction to our character, and see what happens. You can click on Affliction, 
and then click the Add button to add it to your character, or you can simply double-click 
on Affliction. When you do, you’ll see a dialog that looks like this: 
 

 
 
This is an input box, which you’ll see with a number of advantages and disadvantages in 
GCA when you need to specify details for your character. In this case, you need to 
specify the nature of the character’s Affliction. If you click the Cancel button, or click 
OK without entering anything, the Affliction will not be added to your character. 
 
Enter something for the nature of the Affliction – such as Blindness – into the text area, 
and click OK. 
 
A new dialog pops up, asking you to select a skill (or attribute) to use with the affliction. 
It looks like this: 
 



 
 
We’ve selected Will, so why don’t you do the same. Click on Will inside the checkbox to 
place a check in it. Then, click the OK button. 
 
Your character now has the ability to afflict others with blindness! 
 
Now the newly added Affliction is on the list of character advantages, which looks like 
this: 
 

 



 
While you have Affliction selected, look down at the bottom right area of the window, 
next to the Edit button. See that button that looks like an up arrow above a down arrow? 
That’s an up/down button. This button lets you adjust the level of the currently selected 
trait. If you click the up arrow, you can increase the level of the trait, and if you click the 
down arrow, you can decrease the level. Try clicking a few times; that’s how you’ll 
change the levels of most traits that you work with in GCA. 
 
You can change the level of any trait with multiple levels by using the up/down buttons. 
See the green icon next to the Affliction on the Character list? The staircase icon means 
that Affliction has multiple levels. When you see this icon next to a trait, you’ll know it 
has multiple levels. Frequently the number of levels is limited, however; when the level 
stops responding to the up/down button, that’s usually why. 
 
You’ll notice that there’s limited room to show the names of items in the lists, so 
sometimes you may find that the names of items in the Character list won’t be fully 
visible. You can resize the window to make more room, but items that have Modifiers 
(Enhancements or Limitations) will have so much information there’s just not going to be 
enough room. If you click on the Edit button, however, you can see all the information on 
a trait in its own dialog box. (You can also double-click on the trait in the Character list 
to open it in the Edit window.) 
 
The window you’ll see is the Simple Edit window, which looks like this: 
 



 
 
You can now see all pertinent information about the trait in question (although there isn’t 
much here, in this case), and change many of the fields – even the Name. The Name 
Extension field is what appears in parentheses after the Name of the item in the listings. 
In this case, the extension is Blindness, which is the nature of our Affliction. Name 
extensions may cover a lot of different things, including specialties or other special cases. 
 
If you look down the list of fields along the left side of the window, you see that GCA has 
all the bonuses that might be applied to this trait, any necessary prerequisites (called 
“needs”), what bonuses the trait may grant to other traits (called “gives”), and even the 
current Modifiers being applied. 
 
Look at the Current Modifiers section of the window. Right now, our Affliction has no 
modifiers, so let’s make it into an Aura. 
 
Click on the Modifiers button, to the right of the Current Modifiers display area, and 
below the Full Edit Window button. That will open the Modifiers window, which looks 
like this (again, you may want to resize it to get a better view of the lists): 
 



 
 
This window looks just like the Advantages dialog screen from earlier, and works the 
same way. On the right are all the Modifiers currently attached to the trait (listed at the 
top of the window), and on the left are all the ones that are available. Affliction has a 
wide variety of possible options, so be careful. Also, GCA does not prohibit you from 
taking conflicting or redundant modifiers. You could easily spend more points than 
necessary, or create an unplayable set of modifiers. 
 
Now, we want to add Aura to our Affliction, so let’s find it on the Available list, and add 
it to the Affliction. Also, because Aura requires Melee Attack: Reach C (Basic Set, page 
102), we’ll add that as well: 
 



 
 
When you’re done, click the OK button to return to the Simple Edit window.  
 

 
 



You can see your new modifiers in the Current Modifiers section, and you can see that 
the points display is now showing the new 15 point cost of the affliction. 
 
Now, let’s click on that Full Edit Window button, which will take us to the more complex 
Edit Items window, which looks like this: 
 

 
 
This has many of the same fields as the Simple Edit window, but more of them are 
changeable, including some that could radically change the trait. Only a few fields of 
reference material cannot be altered. 
 
The “nameext” edit area will let you change the name extension for the item. For 
example, you could change your Affliction from Blindness to Paralysis. The “cost” field 
will let you change the cost of your Affliction. For example, if you want Afflictions to 
cost 20 points per level instead of 10, you could change the cost to 20/40 here, and your 
new Affliction would instantly be ready to go in your campaign. 
 
Most GMs will not appreciate players changing the point costs of character traits behind 
their backs . . . but if you’re working with the approval of your Game Master, or trying 
out some house rules, or you are the Game Master, the ability to tweak the GURPS 
Fourth Edition character creation rules can come in very handy.  
 
This window also has a Modifiers button, and an up/down button, so you can change the 
levels or modifiers for any trait from here as well. 



 
Click OK to return to the Simple Edit window. Click OK again to return to the 
Advantages dialog. You’ve gone quite a way into the depths of GCA already! 
 
Click OK in the Advantages dialog, and return to the Quick View. 
 
Notice that the Advantage we added is now displayed here, in blue text, as shown below 
(we dragged the page up a bit for a better view): 
 

 
 
In the Quick View window, the Affliction trait text wraps across more than one line, so 
you can see all of its modifiers. The blue text means we can get an edit bar for that trait if 
we click on it. 
 
Let’s click on the Affliction advantage text, and see the edit bar. It looks like this: 
 

 



 
There is an up/down button here too, to change leveled traits. If you click the up or down 
buttons, the level and point cost will change. 
 
The red X button allows you to delete the trait. Go ahead and click that now (don’t worry, 
GCA will ask if you mean it). GCA will pop up a dialog box asking for confirmation. 
Click No, and don’t delete it. On the right side of the bar is an edit button. That button 
will take you back to the Simple Edit window. 
 
Clicking on a blank portion of the page will remove the edit bar, but changes made to the 
trait will be saved. 
 
Now you’ve covered the basics of using the Quick View window to manage your 
character. Try the other buttons in the Quick View window, and you’ll see the idea 
behind the dialog screens that pop up are the same, whether you’re working on 
advantages, quirks, skills, or anything else. 
 
And be sure to try the other buttons on the button bar, to change zoom levels and to 
switch pages in the Quick View. All of the Spells and Equipment are available through 
buttons on page 2. 



Part Two: Working with the Trait Tab Pages 
 
If you’ve already gone through Part One: Getting Started with GURPS Character 
Assistant, you’re familiar with one of the trait tabs in GCA: the Quick View page. There 
are a number of others: one for each type of trait in GURPS, including attributes, 
advantages, spells, and equipment. Each of these tabs works the same way, except the 
Attributes tab, so we’ll take a look at it first. 
 

Working with the Attributes Tab 
 
You can get to the Attributes tab by using the trait tabs near the bottom of the main GCA 
window. They look like this: 
 

 
 
By default, they’re found at the bottom of the window, above the character tabs and the 
points bar: 
 

 
 
If you have more windows or characters open than room to display tabs for them, then 
scroll buttons will appear, allowing you to scroll side to side. Examples are indicated for 
each of the bottom bars below: 
 

 
 
Find the Attributes tab (use the scroll button if you have to), and click on it to get to the 
Attributes tab page. (You can also get there by selecting Attributes from the list of tabs in 
the Tabs menu.) 
 
The Attributes page looks like this: 
 



 
 
The Attributes tab is the only tab that does not provide a list of available traits to choose 
from. All the available attributes are automatically added to your character when it is 
created. 
 
The Normal View of the Attributes page is shown above. This view provides you with 
some summary data on the right side, and the main attributes and secondary 
characteristics on the left. You can also enter your character’s name here, as well as your 
own (which simplifies keeping track of who made what character when you share a 
computer). 
 
Below the attributes listing, you can see an Edit button, with an up/down button next to it. 
The up/down button allows you to change the current score of a selected attribute. You 
can also change scores by clicking directly on them and entering the new value. 
 
Try clicking on the ST score, in the Score column. You should see that area change into 
an edit field, with the current score highlighted and ready to be typed over. It should look 
like this: 
 

 
 



If you type in 12 and then press Tab or Enter, GCA will make the change to ST and 
calculate the cost. The value under the Pts column will change, as will the value for 
Attributes in the Points bar at the bottom of the screen. (Encumbrance and Basic Damage 
will change as well. Most changes in GCA happen “live” and affect all aspects of your 
character immediately.) 
 
Try clicking on the IQ stat, but not in the score column. The IQ row will highlight. Try 
adjusting the score using the up/down button. The IQ score goes up or down in response 
to the up or down arrow. 
 
All that’s left to try is the Edit button. With IQ still selected, click on the Edit button. 
This will open the Edit Items (Simple) window for IQ. It should look like this: 
 

 
 
If you’ve already gone through the Getting Started with GURPS Character Assistant 
tutorial, you already know how this window works. If you haven’t, please refer to that 
tutorial, above. 
 
WARNING: You can use this screen to change the name and name extension of 
attributes. You should NOT do that, ever, unless the attribute is one of your own 
creation. GCA searches for attributes by name when getting their values for other 
calculations. Changing the names of attributes in GCA will result in GCA not being able 
to find them. For example, if you change the name of IQ to something else, you will no 
longer be able to get scores for Perception, Will, or any IQ-based skills, as GCA will 
think that the character’s IQ is 0. 



 
When closing this window, the safest thing to do is to click on Cancel, just in case you 
changed something you didn’t want to change. 
 
You should be back at the Attributes window. Take a look at the Table View by clicking 
on the Table View tab at the bottom of the window. It looks like this: 
 

 
 
The idea behind this view is much like that in the Normal View, but it shows all the 
available attributes, in alphabetical order. It also shows their abbreviation. This is usually 
(but not always) a shorter alias for the attribute that can be used in various calculations 
that come up when building or playing a character.  
 
Other than having access to attributes that aren’t available in Normal View, you shouldn’t 
need to use the Table View very often. 
 
Now let’s take a look at one of the other trait tabs. Once you’ve used one of them, you 
should be able to use any of them. 
 

Working with the Skills Tab 
 
To get to the Skills tab, you can either click on the Skills tab in the trait tabs, or select the 
Skills option from the Tabs menu. The Skills tab looks like this: 
 



 
 
If you’ve already gone through the Getting Started with GURPS Character Assistant 
tutorial, you know that it’s the same as the trait windows discussed there. The only 
difference is these windows are “live”; they don’t have an OK button to close the window 
– you just go to work on a different tab any time you want. 
 
All the available skills are listed on the left, and your character’s skills will appear on the 
right. At the start, of course, the right side is blank. If you want to look at a smaller list of 
skills, use the drop-down list at the top of the left window to select limited categories of 
skills. This will limit both columns, so remember to set it back to “All Categories” to see 
everything your character has. 
 
In the middle are buttons to let you add traits you’ve selected to your character, or to 
remove them again. 
 
Below the Character Skills list is a small group of buttons. The Edit button allows you to 
edit items added to the character. To the right of that is an up/down button, which allows 
you to increase or decrease the points spent on a selected skill. The button with the icon 
of a hammer and chisel is the Modifiers button. Clicking that will open the Modifiers 
window and adjust any enhancements or limitations that should be applied to the skill. 
(Usually, you won’t need the Modifiers button for skills, but it will come up frequently 
for other traits). 
 
For a test, add the Acrobatics skill to your character. You can click on Acrobatics and 
then the Add button to add it to your character, or you can double-click on Acrobatics. 
You should see Acrobatics listed under Character Skills, with one point spent on it, and 
the resulting level. It should look like this: 
 



 
  
Now that you have the Acrobatics skill, you can use the up/down button to put points into 
it, or to take points away. Try it a few times, then click the down button until there are 
zero points in the skill. When you reach zero points, a new icon appears next to the skill 
name – a blue “d”, which means the skill is being defaulted from another trait. It looks 
like this: 
 

 
 
Now we’ll go to the Simple Edit window. With Acrobatics still selected in the Character 
Skills list, click the Edit button, and you will see a window like this: 
 

 
 



The Name field allows you to edit the name of the skill. 
 
The field labeled Name Extension allows you to specify a name extension for just about 
every trait in the program. This name extension is what appears in parentheses after the 
main name of the trait in the listings. In this example, the field is blank. Name extensions 
cover a lot of different things, including specialties or special cases. 
 
If you look down the list of fields along the left side of the window, you see that GCA has 
all the bonuses that might be applied to this skill, any necessary prerequisites (called 
“needs”), what bonuses the trait may grant to other traits (called “gives”), and even the 
current Modifiers being applied, if any. 
 
Of interest right now is the Defaulted From field, which indicates that Acrobatics is 
currently defaulting from DX. Any time a blue “d” icon is on the Character Skills list, 
you can open the Edit window to see what that skill is defaulting from. 
 
Many skills can default to other skills, even if points have been spent on them. The blue 
“d” icon may appear even with a few points in the trait, and sometimes the points spent 
don’t move in the progression that you expect. When buying up a skill from a default 
value, the points spent can look wrong at first, but remember that you may be getting 
some free points in the skill, courtesy of the default. 
 
In the case of techniques, you will always see the blue “d” icon, because they’re always 
based on some default from the controlling skill. 
 
Click OK to close the Edit window and return to the Skills window. (For more on what 
the Full Edit Window and Modifiers buttons do, see Part One: Getting Started with 
GURPS Character Assistant.) 
 



How Do I Create a New Template? 
 
At this time, it is only possible to create new racial templates within GCA, and save them 
to a data file. You can then load your custom data file and have the new template 
available for use with your characters. 
 
It is not possible to create a new racial template within GCA that applies to the current 
character. You’d first need to follow the instructions below to create a new template, and 
then apply the template to the character. 
 
For our tutorial example, let’s create a Dwarf template. 
 
1. Create a New Character 
 
The first step in the process is to create a new character. You want to make sure you’re 
starting from a new character so that you don’t accidentally include any attribute 
adjustments or traits that shouldn’t apply. 
 
2. Change the Name to the Race 
 
Change the name of the character to the name of the race you’re making. In our case, 
that’s Dwarf. 
 

 
 
3. Make Attribute Adjustments 
 
Now you’ll set the correct attributes for a normal representative of your race. For our 
Dwarf, that means raising HT by one to 11, raising Will by one to 11, and lowering Size 
Modifier to -1. 
 

 
 
4. Add Traits 
 
Now you’ll add all the traits that you want members of your race to have. Whether it’s 
advantages or spells, add them to the character the same way your would if you were 



creating a character. For our Dwarf, that means adding a number of advantages: Artificer, 
Detect (Gold), Extended Lifespan, and Night Vision. We also want our Detect to be 
Vague, so we’ll add that modifier to it, as well. 
 

 
 
5. Save As Template 
 
Once you’re done with adding the traits, all the features you need for your racial template 
are there. Now you can save the template to a custom data file. 
 
From the File menu, select Save As… 
 
In the Save File As… dialog, type the file name for your custom Dwarf template. I’ll use 
My Custom Data, since I’ll probably want to store more stuff in there later. Then change 
the Save as type: drop-down list to “Template within Data File (*.GDF).” These changes 
are shown at the bottom of the window here: 
 

 
 



If you want to save your custom data file in the same folder that contains the other data 
files, you may also want to browse into the “data files” folder, or the appropriate folder 
for where you installed your data files. 
 
Finally, click the Save button to start the saving process (it’s not quite done yet). 
 
6. Set Template Options 
 
The Template Options dialog will appear before the Dwarf is actually saved to the file. It 
looks like this: 
 

 
 
Set the appropriate options for the template. To mimic how the official Dwarf template 
works in GCA, you’ll want to check all of the boxes, as shown above. 
 
7. Done! 
 
Once you’ve set the template options, click OK and your template will be saved to the 
data file you selected above. If you entered a file name for a file that did not already exist, 
GCA will first confirm that you want to create a new file: 
 

 
 
Click Yes, and the file will be saved. 
 



Your template has now been created and saved, so you’re done with the creation process. 
You can now close the character that you used to create the template, since it’s no longer 
necessary. 
 
The only step left is to… 
 
8. Load the Data File 
 
Now you need to load the data file that contains your new template. (Even if you are 
already loading the file as part of your normal data set, you’ll need to have GCA reload 
the file in order to get the new data you’ve saved to it.) 
 
Click on the Tools menu, and select Options… On the Data Sets tab, click on Change & 
Load Data Files. Browse to the folder where your data file is stored, if you aren’t already 
there, and add it to the Included list, as shown here: 
 

 
 
Click OK to close the window and automatically reload the data files. 
 
Your new template is now available for use with your characters, even those that you 
already have loaded. 
 


